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Introduction
General

Compact Contact Center Modules (CCC) provides the user with the
necessary tools to facilitate the management of call traffic.  They are
designed to provide a tightly integrated real time and historic reporting
package and wallboard support for the eBusiness digital communications
platform.  The product consists of a set of fully integrated modules sharing
a common database utilizing Interactive Directory and Database (IDD)
technology.
The suite of modules consists of the following applications:

• Call Center View (CCV):
Provides a management package for telephone based staff and
supports any size Customer Facing Department (CFD) or call center.
To effectively control customer service levels, real time human
resource management is essential and the Call Center View has been
specially designed to manage the CFD’s or call center’s most valuable
and expensive asset – its people.

• Call Center View Alarm Reporter:
Provides information (for each Call Center Profile) about alarms that
have occurred within the Contact Center.  The detailed alarm
information for each directory number is presented in report format,
which can then be printed.

• Wallboard Manager:
 Wallboards allow managers and staff to monitor the service being
provided and respond immediately.  Wallboards provide current
information on the number of calls waiting, response times and service
levels.

• PC Wallboards
The PC Wallboard delivers traditional wall mounted wallboard
functionality to the desktop but with the additional benefit of each PC
Wallboard agent being able to configure and monitor a personalized
view of the contact center.  The PC Wallboard also allows agents to
increase their productivity and maintain revenue levels with the added
benefit of managing customer callback requests.

• Report Manager:
Provides in depth historical reporting on CFD or call center activity.  In
addition to call information, the Report Manager also reports agent
activity.  This powerful package allows individual call records to be
stored and reported upon months later.

• Report Designer:
The Report Designer is a software tool used for querying and
reporting.  It enables the user to create reports that contain data from
their call center database and schedule reports to be updated and
printed.

• CCC User Access.
This allows the user to have security and store their personal view of
the call center activity.
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Call Center View (CCV)
CCV provides the customer with the combination of real time service
monitoring and resource management.  A supervisor can manage and
improve the service they provide with full real time visibility of all of their
resources whether the resources are equipment or people.
For a supervisor to effectively manage staff who spends a significant
amount of their time on the telephone, the availability of real time
information is essential.  The CCV allows the supervisor to balance their
resources (i.e. staff against the traffic level of incoming calls) and therefore
improve customer service and reduce cost.
When CCV is launched, the user is presented with a registration screen at
which they enter their profile name.  The telephone switch database, the
user’s configuration as well as the call statistics for that day is loaded on to
the CCV.  The real time screens contained within the CCV are as follows:

• General Screens:
Alarm Handling
DN Activity
BLF Details
Callback Request

• Agent Based screens:
Group Monitor
Individual Agent Details
Agent Group Details
Percentage Time in State
Real Time Status
Individual Agent Group Details
Group Status (Percentage)
Group Performance Monitor

• Queue Based Screens:
Queue Monitor
Individual DID Details

• Trunk Related Screens:
Trunk Group Monitor
Group Status (Percentage)
Individual Trunk Group Details
Individual Trunk Details
Real Time Status

CCV Users Access Level
If you have logged on with the user name Admin, you are able to delete
schedules. All other user names entered have full functionality except
being unable to delete schedules.
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Launching Call Center View
Starting Call Center View

Before starting Call Center View (CCV), you must ensure the Delta Server
is running.
Call Center View is started by:
1. Click the Start button on the Windows taskbar.
2. Point to Programs.
3. Point to CCC.
4. Click Call Center View from the sub-menu.

When you start Call Center View the Login Profile to Call Center View
screen will show. From the screen you can logon using an existing profile
or create a new profile.

To Connect Using an Existing Profile:
Click the pull down arrow to display a drop down list of the existing profiles.
Select the required name and then click the Logon button.  The Loading
Setup Details screen appears.
If in the splash screen, the "Reconnect to last known Delta Server" option
is selected, then the Call Center View will automatically connect to the last
connected Delta Server

Note 1: If in the splash screen, the "Reconnect to last known Delta Server" option
is NOT selected, then the Search screen appears indicating the Call Center View is
searching for the Delta Server(s).
Once the Delta Server(s) has been located, the Find Server screen appears listing
the available server(s).  Select the required server and then click the Connect
button.

If your required Server is not listed, click the Advanced button.  Select one of the
search options and then click the Search button.

Note 2: Profile Names and their individual configuration are only saved in the PC
hosting the CCV application.

To Create New Profile
1. Select the profile name New Profile, and click the Logon button.
2. Enter a Profile Name, and then click the Create button.
3. Click Yes to create the New Profile name and then the Loading Setup

Details screen appears.
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Undefined Directory Numbers
Once CCV is running, the directory numbers information from the
Telephone switch are downloaded automatically via Delta Server.

As a New Profile, the Set Up screens provide only the information
received from the telephone switch.  The View options are enabled once
the Set Up screens are configured.

As an existing Profile, "Undefined" will be displayed in the configured Set
Up and View screen(s) until all the directory number information is
downloaded from the telephone switch.

Administering CCV
Configuring Call Center View for a User's Profile

1. Ensure you are logged onto CCC User.
2. Start Call Center View application, create the User's Profile and

configure the CCV according to the User's requirements.  See "Set Up
Call Center View" on page 12.

3. Ensure you Save the configuration in each Set Up screen.
4. Exit the CCV application.

Function Keys
Some functions may be selected by pressing the shortcut function keys
listed on the menu to the right of the command.

• F1 – Help
• F2 – Print current screen
• F3 – Next screen
• Shift + F3 – Previous screen
• F4 – First Alarm

Help
The Call Center View Help File uses a context-sensitive help format.  This
means that you can obtain detailed information about any of the CCV
screens.  You can access Help in two ways:

− With the screen displayed, press F1; or
− From the menu bar, click Help, and select the required information.

The Help topic for the selected option will be displayed.
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 Call Center View Main Screen
This section provides an overview of all elements on the CCV screen, such
as menus, toolbar buttons and the information bar.
Descriptions of the toolbar buttons are displayed on-screen when the
mouse pointer pauses on them.  The buttons on the toolbar are as follows:

•  "Send Message" on page 8:
 Send a message to Wallboard Device

•  "Print a Screen" on page 10:
 Print the current screen

•  "Group Monitor" on page 35:
 Monitor the selected agent groups

•  "Trunk Group Monitor" on page 44:
 Monitor selected trunk groups

•  "Group Status (Percentage)" on page 40
 Monitor a summary of the percentage of agents as well as trunks in
each state

•  "Queue Monitor" on page 48:
 Monitor directory number's (Groups, Trunks or Agents) response
statistics in real time

•  "BLF Details" on page 50:
 Monitor the real time status of directory numbers

•  "Dn Activity" on page 51:
 Monitor the status of the directory numbers in greater detail

•  "Alarm List" on page 52:
See the chronologically listed alarms

•  Prev Details/Next Details
 Select the next or previous screen

•  Set Up:
 Configure/edit the configuration for a particular screen, as detailed in
"Set Up Call Center View" on page 12

•  “Group Membership Analysis” on page 11:
Analyzes the configuration of the telephone system ensuring
consistencies throughout and preventing issues that may cause
incorrect data input into the historical database – un-named members
or duplicate entries in groups.

•  Alarm indicator status:
Indicates the alarm status, as detailed in "Alarm List" on page 52

The information on the status bar displays the following:
User Name (Access Level) and Profile Name; Site Name (from License file)
and Time and date
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File Menu Options
Send Message

This option allows you to send a message to the Default Wallboard 10/22
device, as well as any active PC Wallboard(s).
See the Wallboard Manager User Manual for setting a wallboard device as
default.

1. From File menu, select Send Message, the Send Message screen
appears.

2. Place the cursor in the Message text box; type message.
3. Duration is the length of time your message is listed on the Schedule

List.  The message is displayed on the relevant wallboard(s) with
respect to the Priority Level of the Scheduled Messages.
To alter the Duration, in seconds, of your message on the Schedule

List, click the  spin button until the required time is achieved.
4. Select Standard Message and then click Send.  The message is

displayed on all active PC Wallboards as well as all the selected
Wallboard 10/22 within the Alarm Settings option of the Wallboard
Server.

5. Select Supervisor Message option to send the message to a specific
active PC Wallboard:
• Audible Alert: enables/causes the selected active PC Wallboard

to provide an audible warning;
• Agent ID: allows you to select an active PC Wallboard, click

Agent ID, Wallboard Server Browser screen appears, listing all
the active PC Wallboards.  Select the required one and then click
Done.  Click Send to display the message on the selected the
active PC Wallboard.

Supervisor Messages
This option is not currently supported.
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Call Back Request
The Call Back Request feature, when used in conjunction with the Voice
Manager Pro, allows the supervisor to view a list of incoming callers who
have selected the option of call back from the Voice Manager.  Further
details are available in the "Call Flow Manager Manual" for the setup of this
feature.
Call Back Request feature can also be utilized in conjunction with the PC
Wallboard to allow the supervisor to assign callback messages to the
agents that are logged on to the PC Wallboard application.  Further details
are available in the " Wallboard Manager Manual" for the administration of
the callback messages.
This option allows you to administer a list of callback messages received
from the Voice Manager as well as to assign call back messages to the
agents via the PC Wallboard.

Create a Call Back Request message
1. From the File menu, select Call Back Request.
2. Right click anywhere on the pane and select Add from the list of the

popup menu. When you select Add the dialogue box expands to give a
bottom section allowing you to add a callback request.

3. Use the spin buttons to select the Dn Name or double click in the text
box to access the DN Search screen and then select the required
directory number.

4. Enter the incoming Caller ID number for the agent to call back the client
in the Add Caller ID section.

5. Click Add to include it to the Call Back Request list and then click
Close.

The Callback Request List displays the following information:

• Date: The date when the callback request arrived
• Time: The time when the callback request arrived
• Caller ID: The Calling Line Identity, i.e. the telephone number, of the

caller requesting the callback option
• Original Target: The Directory Number /Name that the incoming call

was originally targeted at i.e. the agent group or voice manager group
• Status:

• Waiting – Callback Request message waiting to be assigned to
an agent.

• Actioned – Callback Request message that has been assigned to
an agent.

• Cleared – The agent has dealt with the Callback Request.

Assign a Callback Request message to an Agent
1. To assign a Callback Request message to an agent, right click the item

and then select Action from the list of the popup menu.  (See example
above) If Action is greyed out, this Callback cannot be forwarded to an
agent since it contains non-numerical characters.

2. From the Wallboard Server Browser screen, which displays a list of
active PC Wallboard(s), click the required PC Wallboard.  Click Done.
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Remove Callback Request Message
To remove an item from the list, click (using right mouse button) the item
and then select Remove from the list of the popup menu.

Print a Screen
Ensure a printer is available either locally (i.e. connected to the PC hosting
the CCV) or remotely (i.e. connected within the network).

By default, the print buttons  (on toolbar) and  (on Set Up and View
screens) will be enabled when you open a screen incorporating the Print
option.
To print a current screen either:

• from the screen, click Print; or

• from the toolbar, click ; or
• from the File menu, select Print; or
• from the keyboard, press F2.

Save Callback Request
When the Call Back Request List is saved a file is created called
"callback.dat".  The data is saved as comma separated text.

Network Details
To open the Network Details screen, from the File menu, select network
Details.  The Network Details screen displays the following information:

• Connection – The PC hosting Delta Server that the CCV is
connected;

• Dn Activity – The download of the directory number information.
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Group Membership Analysis
The telephone switch Analysis option analyses the configuration of the
programming.  It displays any problems; therefore, ensuring
inconsistencies are eradicated throughout which will prevent issues that
may cause incorrect data input into the historical database.
The telephone switch Analysis highlights the following inconsistencies:
• Un-named Agent devices;
• Mixed device types i.e. Agent and Trunk devices within the same

group.

• Click telephone switch Analysis icon .
• Click Refresh to ensure the displayed information is up to date.

• Click  to display a description of the icons  and  for both
the Agent and Trunk groups.

• Click  again to remove the description.

Agent Groups
•  This indicates that group members are of the same device type

and all members are named.
•  (on left hand column) One or more group members are of differing

device types (Trunk/Agent, etc.)
•  (on right hand column) Either the group is unnamed or any one of

its members is unnamed.
Further telephone switch Analysis is provided within the “Real Time Status”
on page 38 for Agent Group Membership.

Trunk Groups
•  This indicates that group members are of the same device type

and all members are named.
•  (on left hand column) One or more group members are of differing

device types (Trunk/Agent, etc.)

Note
 on the right hand column will always be ticked, as Trunks are not normally

named.
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Set Up Call Center View
General

This section explains the Call Center View Set Up screens and the
necessary steps for configuring the program.  On startup, the directory
numbers database is automatically downloaded from the Telephone switch
via the Delta Server to the Call Center View.

All the Set Up screens have a Print option.  This allows you to print the
current Set Up screen.

Each Set Up screen has a Save option.  When selected, the configured
information for the logged on Profile is saved in the hard drive of the PC
(C:\) or in the Network drive and will override the previous configuration.
However if Save is not selected, when exiting Call Center View application
(or logging on a different Profile), then the configured details are lost for
the current Profile.

Set Up screens have Next and Previous options.  These allow you to
move forward to the next or back to the previous screen, without exiting the
current screen.

Language
This option allows you to select a different language if the Call Center View
incorporates multi-language facility.  By default, the Language is set to
English.

From the Set Up menu, select Language.  Click the required language.

Wallboard Msg Database
When you choose this option from the Set up menu, you need to select the
wallboard database from the dialogue box (Wallbrd.mdb).  Once selected
click on the open button.
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User Data Path
This option allows you to access the Call Center View Profiles across the
network.
Once the Network path has been established, every User (regardless of
their Access Level) need to perform the following instructions from their
own PC (to gain access to their individual Profile):

1. Start CCV.  Log on as New Profile.  From the Set Up menu, select
User Data Path, the Setting User Data Path screen appears.

2. Select the created network drive and path, e.g. N:\Users.  Click Save.
3. Exit CCV application.
4. Restart Call Center View, Log on with your Profile Name and use the

CCV according to your Profile configuration.

Show Network Details on Start-up
This option is used to display the Network Details screen every time you
start the Call Center View.  To set this option:

• From the Set Up menu, Select the Show details on Start Up Option.
A check placed next to this option in the Set Up menu indicates that this
has already been selected.
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Group List
The group monitoring screen puts the supervisor in control of their agent
skill groups or campaigns, allowing them to monitor the status of these.
The supervisor may view 6 groups on each screen and scroll to
subsequent screens to view more groups (up to a maximum of 10 screens)
thus enabling the supervisor to monitor large numbers of groups
simultaneously.

From the Setup menu, select Group List, the Group List Selection screen
appears.  This option allows you to select groups (excluding Trunk Groups)
to be displayed on the Group Monitor View screen.  (Group Monitor View

Button )

To Add a Group
The information regarding all the groups within the Telephone switch are
listed in the Available Groups list box.  Up to a maximum of 60 groups can
be added to the Display Group.

To add a required group to the Display Groups, from the Available
Groups either:

• double click a required group;
or
• select a group, then click the Add button.
To move a group up or down the Display Groups list, click the required
group and then click Move Up or Move Down.

To Remove a Group
To remove a group from the Display Groups list, either:

• double click on the required group;
or
• select a group, then click Remove.
To move a trunk group up or down the Display Groups list, click the
required group and then click Move Up or Move Down.
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Trunk Group List
The Trunk Group Monitor screen allows the supervisor to quickly and easily
monitor the state of their groups to view traffic levels, ensure that they have
enough lines to cope with call volumes, control call costs and identify any
faults.  The supervisor may view 6 groups on each screen and scroll to
subsequent screens to view more groups (up to a maximum of 10 screens)

From the Set Up menu, select Trunk Group List, the Trunk Group
Monitor screen appears.  This option allows you to select trunk groups to
be displayed on the Trunk Monitor view screen.  (Trunk Monitor View

Button ).

To Add a Trunk Group
The information regarding all the trunk groups within the telephone switch
are listed in the Available Trunks list box.

Up to a maximum of 18 trunk groups can be added to the Display Trunks.

To add a trunk group to the Display Trunks list, from the Available
Trunks list either:

• double click a required trunk group;
or
• select a trunk group, and then click the Add button.
To move a trunk group up or down the Display Trunks list, click the
required group and then click Move Up or Move Down.

To Remove a Trunk Group
To remove a trunk group from the Display Trunks list either:

• double click a selected trunk;
or
• select a trunk, then click the Remove button.
To move a trunk group up or down the Display Trunks list, click the
required group and then click Move Up or Move Down.

Group Display
This option allows you to select a group statistics to be monitored on the
Group Monitor and Trunk Group Monitor View screens.  (Group Monitor

View Button  and Trunk Group Monitor Button ).  It is possible to
select 5 parameters for each group to be displayed on the group icon.  In
addition, a number of fields may be selected to be shown at the bottom of
the screen as totals for the groups on display.

From the Set Up menu, select Group Display.  The Group Display
Selection screen appears.  This screen allows you to set the required
Group Statistics for agent and trunk groups as well as directory numbers
selected within the Queue Monitor.
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Change Display Selection
There is a maximum of five different Statistic Display Selections for
every group.  As shown in the diagram below, each statistic display
selection is set by default to PCA All, GOS All, Lost All, Calls Waiting and
Answered All.  Each Selection contains the fields listed in the table below.

The Group List statistics can either be set to the same statistics as the
selected groups or be a different setting.

To alter the Group Display Selection for a group, select the group.  Click
the pull down arrow associated with a selection and select from the listed
options.

• PCA All: The number of all calls (internal and external) answered
within the target answer time expressed as a percentage of internal
and external answered calls.(PCA = Percentage of calls answered)

• PCA Ext.: The number of external calls answered within the target
answer time expressed as a percentage of external answered calls.
(PCA = Percentage of calls answered)

• GOS  All: The number of all calls (internal and external) answered
within the target answer time expressed as a percentage of internal
and external calls presented.  (GOS = Grade of service)

• GOS  Ext.: The number of external calls answered within the target
answer time expressed as a percentage of external calls presented.
(GOS = Grade of service)

• Lost All: The total number of all incoming (internal and external)
unanswered calls today.

• Lost Ext.: The total number of external incoming unanswered calls
today.

• Calls Waiting: The total number of calls waiting for the group.
• Answer All: The total number of all calls (internal and external)

answered by members of the group.
• Answer Ext.: The total number of external calls answered by

members of the group.
• New Incoming Pres: The total number of incoming calls presented to

members of the group.
• Outgoing All: The total number of all outgoing calls (internal and

external) made by members of the group.
• Outgoing Ext:. The total number of all external outgoing calls made

by members of the group.
• Refused All: The total number of internal and external incoming calls

presented to members of the group not answered by a particular
agent.

• Refused Ext.: The total number of external incoming calls presented
to members of the group not answered by a particular agent.

• L Wait (Ans) All: The longest wait of any internal and external
answered call today.

• L Wait (Ans) Ext.: The longest wait of any external answered call
today.

• L Wait (Lost) All: The longest wait of any lost call (internal and
external) today.

• L Wait (Lost) Ext.: The longest wait of any external lost call today.
• Call Rate: The hourly answered call rate for calls, which are originally

targeted to the selected group.
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• Avg Ans All: The average answer time of all internal and external
incoming answered calls.

• Avg Ans Ext.: The average answer time of all external incoming
answered calls.

• Grp Calls Ans All: The total number of all internal and external
incoming answered calls, answered by agents for this group.

• Grp Calls Ans Ext.: The total number of external incoming answered
calls, answered by agents for this group.

• No on Incoming: The number of agents and trunks currently engaged
on incoming calls.

• No on Outgoing: The number of agents and trunks currently engaged
on outgoing calls

• No on Ready: The number of agents and trunks currently ready to
take incoming calls.

• No on Hold: The number of agents currently holding calls.
• No on BWU: The number of agents currently in busy wrap up.
• No on BNA: The number of agents currently in busy not available.
• No on Busy: The number of agents currently busy.
• No on L/Off: The number of agents currently logged off.
• No on Ringing: The number of agents whose extension is currently

ringing.
• No on Int Made: The number of agents currently making internal calls.
• No on Int Rcvd: The number of agents currently receiving internal

calls.
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Real Time Status (RTS) Display
This option allows you to select statistics for members within a group/trunk
group to be monitored on the Real Time Status View screens.  (Group

Monitor View Button  and Trunk Group Monitor Button ).  From the
Set Up menu, select RTS Display.  The RTS Display Selection screen
appears.  This screen allows you to set the required statistics for agents
and trunks.

Select a Group Statistic
There is a maximum of five different Display Selections for every group.
As shown in the diagram above, each statistic display selection is set by
default to PCA All, GOS All, Lost All, Calls Waiting and Answered All.
Each Selection contains the following the fields as listed in the table below.

1. To alter the RTS Display Selection for a group, select the group.  Click
the pull down arrow associated with a selection and select from the
listed options.

2. Repeat for the required selections.

Note: For details of the parameters refer to page 16

Group Status (Percentage)
An instant graphical presentation of the percentage of agents as well as
trunks is available for each group.  This option allows you to select the
required states which are monitored on the Percentage View screen

(Percentage View Button ).

From the Set Up menu, select Group Status (Percentage), the Group
Status (Percentage) screen appears.  By default, all the states are
selected for the Agent Group and only 5 states are available for the Trunk
Group.  Click  to deselect a state for either Agent Group or Trunk Group.
“State Details” on page 32 details the procedures required to change the
color of the states (the text as well as the background).

Queue Monitor
Queue Monitor has been designed to monitor the call traffic by allowing the
supervisor to display up to 180 queues in real time via 20 screens, each
containing 9 queues.  These queues may represent trunks, trunk groups,
agents and agent groups.

From the Set Up menu, select Queue Monitor.  This option allows you to
select the directory numbers to be displayed on the Queue Monitor View

screen (Queue Monitor View Button ).  There are twenty queue lists (1–
20) available.  Within each queue list, you can monitor up to nine directory
numbers.

To identify a Queue List, click the spin button , until the required Queue
List Id appears.

To identify each Queue List, place the mouse cursor in the Queue Name
text box and then type a name.



Set Up Call Center View Queue Monitor

CCC Call Center View Page 19
User Manual 40DHB0002USBB Issue 2 (07/17/2001)

Select Directory Numbers
You can select directory numbers in 2 ways:
Spin Buttons
To select a directory number (0000-9999), click and hold the mouse on the

spin button  until the required directory number appears in the left-hand
box.

Dn Search
Double click a directory number entry box the Dn Search screen appears.

a). Dn Selection
By default, the Available Dns list box contains all the directory numbers
within the Telephone switch associated with the selected Dn Selection
categories (i.e. Group and Agent).
If only one category has been selected then only the directory numbers
associated with that category will be displayed in the Available Dns list
box.
1. To deselect any of the categories, click  associated with that

category.
2. To select any of the categories, click  associated with that

category.
b). Set the Directory Number Order

The Available Dns can be in three different orders:
− Dn (Directory Number 0000-9999); or
− Name (Directory Number name alphabetically); or
− Type (Directory Number type alphabetically).

Click  associated with the required order.
c). Select Directory number

– Click the required Directory Number, then click ; or
– Double click the directory number.

Delete Directory Number
To remove the selected directory number, from the Queue Monitor Set Up
screen, double click a directory number entry box, the Dn Search screen

appears.  Click  associated with Delete Entry.  Click , "Not
Initialized" will be displayed in the directory number entry box.
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BLF Details
The BLF screen has been implemented to provide an overview of up to 240
directory numbers on the system in real time.  This screen allows agents,
groups, trunks and DID’s to be displayed on a completely free format basis
in order to gain a perspective on all elements of the system.

From the Set Up menu, select BLF Details.  The BLF Details screen
allows you to select directory numbers to be displayed on the BLF Details

View screen (BLF View Button ).  There are 240 entries available.
They are divided into 4 tabs each containing 60 entries.  Tabs are from 1-
60, 61-120, 121-108 and 181-240.

The Available Dns contained in the top list box can either be in number or
in alphabetic order.  By default, the order is in Dn (directory number) which
lists the Available Dns in numeric order.  Name lists the directory numbers
in alphabetic order.  To change the order, click  associated with either Dn
or Name.

Dn Selection
By default, the Available Dns list box contains all the directory numbers
within the telephone switch associated with the selected Dn Selection
categories (i.e. Agent Group and Agent).
If only one category has been selected then only the directory numbers
associated with that category will be displayed in the Available Dns list
box.

1. To deselect any of the categories, click  associated with that
category.

2. To select any of the categories, click  associated with that category.
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Select Directory Number
There are 240 entries available.  They are divided into 4 tabs each
containing 60 entries.  Tabs are from 1-60, 61-120, 121-180 and 181-240.

1 From the Available Dns list box, click  or  of the scroll bar, or drag
 along the scroll bar to display the required number.

2 If the directory numbers are in alphabetic order, click a directory
number and then type the first letter of the required name.  The cursor
will be placed on the first name beginning with that letter.

3 From the Available Dns list box either:
− click a directory number drag and drop to one of the entry boxes;

or
− double click the required directory number.  The number is placed

in the first blank slot.
4 To move a directory number from one entry box to another, click the

directory number and then drag and drop to one of the entry boxes.
5 "Not Initialized" in an entry box indicates you have not selected a

directory number.
6 To remove a directory number from an entry box, double click the

directory number.  "Not Initialized" is displayed to indicate no directory
number is selected.

Compact Directory Numbers
To display the selected directory numbers, without blank spaces (i.e. Not
Initialized) between entries, click Compact.
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Dn Activity
The Dn Activity screen has been designed to allow the supervisor to drill
down in fine detail to the activities of agents, groups, trunks and DID’s in
real time, by allowing the selection of information from 33 parameters to be
displayed.  The information displayed can be tailored to the supervisor’s
requirements by adding and removing the required information fields.

From the Set Up menu, select Dn Activity. This screen allows you to
select the fields and the order in which they appear on the Dn Activity

View screen.  (Dn Activity View Button ).

As there is no option to select directory numbers within the Dn Activity Set

Up screen; the Dn Activity button  is enabled once you have selected
the required directory numbers in Group Monitor and BLF Details Set Up
screens.

Note - The minimum refresh time of this screen is 5 seconds.

Select fields
By default all the fields are selected, as indicated by  associated with a
field.

1. To de-select any of the fields, click  associated with a field.
2. To select any of the fields, click  associated with a field.
The fields available for selection are shown in the table below.

Agent Group Internal To Overflowed From
Average Abandoned Last Account Code Overflowed To
Average Answer Last Calling Line ID PCA
Average Incoming
Duration

Last Connection Refused Calls

Average Outgoing
Duration

Logged Off At Time In State

Call Rate Logged On At Time On Duty (today)
Calls Waiting Longest Wait Total I/C Call Duration
Cost Today Longest Waiting

(Answered)
Transferred From

GOS Longest Waiting (Lost) Transferred To
Incoming Lost Calls
Internal From Outgoing

Background color
This option allows you to change the background color of the Dn Activity
View screen.

1. From the Dn Activity screen, click Back Color, the color selection
screen appears.

2. Click a color and then click the OK button.
3. Click Cancel to close the screen without selecting a color.
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Alarm Trip Points
Three different alarm tiers may be set for each device enabling the
administrator to set alarm conditions with an increasing degree of severity,
the three different tiers of alarms are classed as Normal, Caution and
Critical.  These three alarm parameters may be set for individual agents,
groups, or trunks on the criteria shown in the following table.  The point at
which the alarm will clear may be set as a percentage of the alarm trigger
time.

Queue Details
Call Waiting (Number) The calls waiting alarm will be triggered when the

number of calls waiting exceeds any of the specified
thresholds

Longest Waiting
(Seconds)

The longest waiting alarm will be triggered when the
length of the longest waiting call exceeds any of the
specified thresholds

PCA  (Percentage of
Calls Answered) (%)

The PCA alarm will be triggered when the Percentage of
Calls Answered drops below any of the specified
thresholds

Average Answer
(Seconds)

The average answer alarm is triggered when the
average answer time exceeds any of the specified
thresholds

Maximum Time in State (seconds)
Incoming The incoming time in state alarm triggers when any of

the specified thresholds is exceeded
Holding The holding time in state alarm triggers when any of the

specified thresholds is exceeded
Busy The busy time in state alarm triggers when any of the

specified thresholds is exceeded
Outgoing The outgoing time in state alarm triggers when any of

the specified thresholds is exceeded
Busy Wrap Up The busy wrap up time in state alarm triggers when any

of the specified thresholds is exceeded
Logged off The logged off time in state alarm triggers when any of

the specified thresholds is exceeded
Ready The ready time in state alarm triggers when any of the

specified thresholds is exceeded
Busy N A The busy not available time in state alarm triggers when

any of the specified thresholds is exceeded
Ringing The ringing time in state alarm triggers when any of the

specified thresholds is exceeded
Internal Made The internal made time in state alarm triggers when any

of the specified thresholds is exceeded
Internal Rcvd The internal received time in state alarm triggers when

any of the specified thresholds is exceeded
Others
Lost Calls Maximum The lost calls maximum alarm triggers when the number

of lost calls exceeds any of the specified thresholds
Overflow to Maximum The inter to maximum alarm threshold triggers when the

number of calls answered by another group and
transferred to a member of this group exceeds any of
the specified thresholds

Overflow from Maximum The inter from maximum alarm threshold triggers when
the number of calls answered by this group and
transferred to another group exceeds any of the
specified thresholds

From the Set Up menu, select Alarm Trip Points. You can reference
alarms to any directory number's alarm variable as explained in "Define
Referenced Alarm" on page 28.  A referenced alarm is indicated with a
blue/cyan background.
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If you do not wish to monitor any alarm category, disable the alarm without
setting its value to zero (0) (For further details see "Alarm Details" on page
31).

Note: Use the right mouse click to enable an alarm and double click the left mouse
button to disable an alarm.

Select Directory Numbers
You can select directory numbers in 2 ways:

1. Spin Buttons
To select a directory number, click and hold the mouse on the spin button

 until the required directory number appears in the left-hand box.

2. Dn Search
Double click a directory number entry box.

a Dn Selection
By default, the Available Dns list box contains all the directory numbers
within the Telephone System associated with the selected Dn
Selection categories (i.e. Group, Agent and Trunk).
If only one category has been selected then only the directory numbers
associated with that category will be displayed in the Available Dns list
box.

− To select any of the categories, click  associated with that
category.

− To deselect any of the categories, click  associated with that
category.

b Set the Directory Number Order
The Available Dns can be displayed in one of the three different
orders:

− Dn (Directory Number 0000-9999); or
− Name (Directory Number name alphabetically); or
− Type (Directory Number type alphabetically).

Click  associated with the required order.
c Select Directory number

− Click the required Directory Number, then click ;
or

− Double click the directory number.
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Specify Alarm Values
1. Click (using the right hand mouse button) an alarm field (e.g. Incoming)

to enable the alarm e.g.
from 
to 
Each alarm field is divided into 4 segments:
• No Alarm (White)
• Normal Alarm threshold (Green)
• Caution Alarm threshold (Amber)
• Critical Alarm threshold (Red)

2. Highlight the digits on the right hand box and type a number that is
divisible by 4.  This value sets the full scale of the alarm.

3. Place the mouse pointer on the a slider (e.g. Normal Alarm) the pointer
changes to , click and drag left or right (increase or decrease) until
the required number/value is displayed within the box.

4. Ensure to perform Step 3 for all alarm settings, i.e. Normal, Caution
and Critical.

5. Click (using the right hand mouse button) an alarm field (e.g. Incoming)
to reference the alarm, see “Define Referenced Alarm” on page 28 for
further details.

6. To disable any of the alarm fields for a specific directory number,
double click the alarm field.

Queue Details Alarm Threshold Clear
The Alarm threshold clear % sets the automatic low and high alarm clear
limits of a directory number for the Queue Details categories.  The
categories are:

• Calls Waiting (No) – Number of calls Waiting;
• Longest Wait (Sec) – Longest Waiting call;
• PCA (%) – Percentage of Calls Answered;
• Average Answer (Sec) – Average call Answer Time.
By default, the Alarm threshold clear % is set to 20%.  The range is 5-
40%.  To increase/decrease the Alarm threshold clear %, click and hold

the spin button  until the required value appears in the left hand box.
This will automatically set the Clear Low % and Clear High %.

Note: The Alarm Threshold Clear % is applicable individually for all the alarm
criteria i.e. Normal, Caution and Critical.

Clear High % is associated with Calls Waiting, Longest Waiting, and
Average Answer alarm categories.  Clear Low % is associated with PCA
alarm category.

To alter any of the Queue Details Alarm fields, see page 25.
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Example for Calls Waiting, Longest Waiting Call, and Average Answer
The flowchart and the table illustrate this example.

If Alarm threshold clear % is set to 20% and the Normal Alarm value is
set to 10.
The alarm occurs when the value is greater than 10 (the specified value).
When it reaches 80% of 10, it will automatically be cleared, i.e. High Alarm
= 10, hence High Alarm Clear =10 x 80%=8.

Queue Wait Value Alarm
7, 8,9
10, 11
10 & 9
8
7

No Alarm
High Alarm
High Alarm
High Alarm Clear
No Alarm
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Example for PCA
The flowchart and the table illustrate this example.

If Alarm threshold clear % is set to 20% and PCA (%) Normal Alarm
value is set to 80.
The alarm occurs when the value is less than 80 (the specified value).
When it reaches 120% of 80, it will automatically be cleared, i.e. Low Alarm
= 80%, hence Low Alarm Clear =80 x 120%=96%.

PCA Value Alarm
PCA

Is PCA 
<or=79? No Alarm

Low  Alarm

Is PCA 
>or=96?

Low  Alarm 
Clear

Y

Y

N

N

97 – 81
80 – 00
00 – 95
96
97

No Alarm
Low Alarm
Low Alarm
Low Alarm Clear
No Alarm

Restore the Alarm Value
If you make an error while specifying the alarm values, Restore allows you
to return the values to their previous number providing you have not
"Applied" the alarm settings to the directory number.

Click Restore to return the alarms to their previous values.

Apply Alarms to Directory Numbers
Once you have selected the directory number and set its appropriate alarm
categories, you MUST apply the alarm setting(s) to the selected directory
number type.  If the selected directory number is a group then you have a
choice of whether to apply the alarm settings to the group and/or to its
members.  A group contains agents or trunks.

Note: If you click Save prior to applying the alarm settings to the selected directory
number, then the alarm settings have NO EFFECT on the directory number
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Define Referenced Alarm
It is possible to set referenced alarms to assist the Contact Center
Supervisor in identifying exceptions.  These alarms provide a real time
comparison of alarm fields (e.g. Incoming) against other devices
performance.  For example:

• Member referenced to its group;
• Member referenced to another member within the group;
• Group referenced to another group.
For example: an alarm may be set to compare one agent group’s call
answering total against another.
When you alter the alarm value of the target directory number, and then
the other directory number's referenced alarm value will automatically
change accordingly.
1. Select a target directory number.  Specify and apply the alarm fields for

the target directory number.
2. Select another directory number.  Click (using the right button of the

mouse) one of the alarm categories.
3. Click  associated with Referenced Alarm.
4. To select the required Target Dn see page 24
5. Click and hold the mouse on the spin button until the required Target

Alarm appears in the left-hand box.
6. Click and hold the mouse on the spin button until the required Target

Percentage (10% – 200%) appears in the left-hand box.
7. Click Apply.

Alarm value background will change to blue/cyan which indicates the
directory number alarm setting have been referenced to a target
directory number.

8. Repeat the above steps for the other directory numbers and alarm
fields.

9. If you wish to disable a Referenced Alarm, click  associated with
Normal.  Then click Apply.
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Alarm Scripts
The CCV Alarm Handling is tightly integrated with the Wallboard Server
software Alarms may optionally be forwarded to the Wallboard Server for
display on the wallboards.
By default, once you have specified alarm thresholds for the directory
numbers (as detailed on page 23) and have also checked the Forward
option in "Alarm Details" on page 31, then when an alarm occurs, the alarm
details, in generic format are displayed on the selected wallboard device(s).

Note
In this manual Wallboard devices are comprised of Wallboard 10, 22 as well as any
active PC Wallboard(s).

• Generic Alarm – Alarm types available in the Alarm Trip Points Set Up
option.

• Alarm Script – Alarm messages accessible from the Wallboard
Server.

The Alarm messages can either be displayed in generic or scripted format,
which are obtained from the Wallboard Server.  [See Alarm Messages
section in the Wallboard Manager Manual].
1. Ensure you have selected the wallboard device(s) as detailed in

"Wallboard Destination" on page 30
2. From the Set Up menu bar, select Alarm Scripts.
Preview shows the format of the alarm message being displayed on the
wallboard device(s).

Scripted Alarm Messages
To display Scripted Alarm Messages, you need to associate the alarm
messages with the Alarm Type.  Alarm Type is the alarm threshold settings
configured for a directory number as detailed on page 23.

1. Click the pull down arrow and select from the listed alarm Type options.
2. Click the pull down arrow and select an alarm Cat (Category), either

Low or High.
3. Click Change the following screen appears:
4. Click Script.
5. Preview shows the layout of the message as will be displayed on the

wallboard device(s).
6. Click the required message.  Click the OK button.
7. To close the screen without making any changes, click Cancel.
8. To change from Script format to Generic format, click Change.
9. Ensure Generic is selected and then click the OK button.

Note
It is recommended to set the PCA Alarm Type to Low Category. Set all the other
Alarm Types to High.
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Wallboard Destination
From the Set Up menu, select Alarm WB Destination.  This option allows
you to select specific Wallboard device(s) within the network to display
alarm messages generated from the CCV application. By clicking the
Modify List button, you will stop sending the Alarm messages (if Forward
has been checked) to the wallboard device(s).  You are then able to select
wallboard device(s) as well as any active PC Wallboard(s).

Note
1. Whilst in this screen, the Forward Alarm option is disabled.
2. To display the Alarm Messages on the selected wallboard devices, ensure you

have checked the Forward Alarms option in the Alarm Details setup screen
3. In this manual, Wallboard device comprises of Wallboard 10, 22 as well as any

active PC Wallboard(s).

Add Wallboard Device
1 Click the Add to List button. The Wallboard Manager Browser screen

appears which lists the Wallboard Servers as well as the Wallboard
Devices within the network.

– To select all wallboard devices double click .  Click Done.
– To select individual wallboard devices, click  (Wallboard

Server), then  type of the Wallboard 10/22 devices, and then
double click  for individual Wallboard 10/22 device, or  for
PC Wallboards, and then  for individual active PC Wallboard.
Once you have selected the required device(s), click Done.

2 From the Alarm Wallboard Destination screen, click Save List.

Remove Wallboard Device
To remove a wallboard device from the Wallboard Destination List,
double click the device.

Wallboard Probe Time
This sets the time interval at which the CCV checks the selected wallboard
device(s) to ensure the connection to the device(s) is still intact.
The default Time is set to 05:00 minutes.  To change the Time click and

hold the spin button  until the required time appears.
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Alarm Details
From the Set Up menu, select Alarmable Details.  The Alarm Details
screen allows you to administer the alarm configurations based on the
following conditions:

1. Alarm: enables/disables an alarm field for all the specified directory
numbers – This means that if you do not wish to monitor an alarm field
for the directory numbers, you can disable it without changing its
configuration for individual directory number.

2. Forward: forwards alarm messages to the wallboard device(s) –select
the required alarm field to be displayed on the wallboard device(s).

3. Default Display Time: the duration of time of the alarm messages
displayed on the Scheduled Messages List of the Wallboard Server.

Note: In this manual Wallboard devices are comprised of Wallboard 10, 22 as well
as any active PC Wallboard(s).

For all the alarm configurations specify the following options:
1. Audio Alarm Set/Clear: This causes the PC to beep every time an

alarm has been triggered and also when the alarm is cleared;
2. Pop Up Alarms: When an alarm field reaches its threshold setting, this

option will cause the First Alarm screen together with the Individual
Detail screen for the directory number to pop up.

3. Generate Alarm Log File: Any alarm that is generated can be saved to
the CCV Alarm Reporter to provide an historic representation of
exceeded alarm conditions.  See CCV Alarm Reporter manual for
further information.
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State Details
This option allows you to select a set of preferred colors for the states.
1. From the Set Up menu, select State Details.
2. To change the Text color of a State, click Back (which changes to

Text).  Then click the state, a Color Selection box appears.
3. Click the required color.  Click the OK button.
4. To change the Background color of a State, click Text (which changes

to Back).  Then click the state, a Color Selection box appears.
5. Click the required color.  Click the OK button
6. To close the Color Selection box without selecting a color, click

Cancel.

Note: If you select Red color an error message will appear preventing you selecting
it.  By default, red background indicates an alarm has occurred.

View logged off Agents
To display all the logged off agents when monitoring directory numbers in
the following View screens, from State Details screen, click Display
Logged Off Agents.

− Real Time Status;
− BLF Details;
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Update Periods
From the Set Up menu, select Update Periods.  This option allows you to
set the time for obtaining the current information from the telephone switch.
To increase/decrease the Update Period for each field, click and hold the
mouse on the spin button until the required time appears in the left hand
box.

− By default, the Update Periods are set to 5 seconds except for Group
Status Percentage, which is set to 60 seconds.  The range is 1-25
seconds with the exception of Group Status (Percentage) which is 1-
1440 seconds.

Note: Dn activity cannot be set below 5 seconds

Default Settings
This option allows you to reset the configured Set Up screens back to
default values.
1. From the Set Up menu, select Default Settings.
2. Click  associated with a field
3. Click the Default button.
4. Click the Yes button to confirm default setting.
5. Click the No button to close the confirmation screen.
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View
General

This section details the CCV View screens.  To open any of the screens
select View from the Menu bar and select the required item from the list, or
click an enabled button (on the tool bar).

If you are logged on as a New Profile, as each option under Set Up menu
is configured, its associated View button on the tool bar will be enabled.
You will also be able to select the option from the View menu bar. Every
time you start the CCV, as an existing Profile, "Undefined” is displayed on
the View screen(s) until the directory number database is downloaded.

Change State Colors
The color of the status of the directory numbers changes as their state
changes.  To select different state colors see "State Details" on page 32.

If you have set an alarm for any of the selected directory numbers (see
"page 23), then when an alarm occurs the background color changes to
red.  To find out about the alarm see "Alarm Details" on page 31.

Change Update Periods
For the following View screens, you can alter the frequency at which the
current information is being updated, as detailed in "Update Periods" on
page 33:

Group Monitor Trunk Group Monitor
Individual Agent Group Details Individual Trunk Group Details
Individual Agent Details Individual Trunk Details
BLF Details PTS Details
Dn Activity Details Queue Monitor
Real Time Status Individual DID Details
Group Status (Percentage)

Modify Configuration
View screens have a Set Up option.  This option allows you to alter the
configuration without exiting the View screen.
To change the configuration, either:

– click on the View screen;
or
– click  from the tool bar;
or
– from the Set Up menu, select your required option.

View screens provide the following features:

1. Close  option that allows you to exit the current screen.
2. Minimize  and Maximize  screen options.
3. Resizing option, which allows you to change the size of a window by

using the mouse to drag a corner or side of a window in any direction.
4. The ability to telephone switching between windows by clicking its

button on the taskbar.  Telephone switching does not close the window
you were working in, it just changes the view on your screen.

5. Default Size  that restores the windows to their original size.
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Group Monitor
This screen allows you to monitor the status of the selected groups within
the CCV Group List.  This real time screen displays the status of the
selected groups.  This screen also displays each group's selected
statistics.
The features explained within the Group Monitor are:

• “Group List” on page 36
• Individual Group Details on page 50

• “Group Details” on page 36
• Individual Group Details on page 45

• “Real Time Status” on page 38
• “Monitor” on page 39
• “Agent Display Positionon page 40
• “Group Status (Percentage)” on page 40
• “Individual Agent Details” on page 41
• “Force Agent Status” on page 43
• “PTS (Percentage Time Summary)” on page 43

Group

Real Time

Individual Agent Group

Individual Agent

Layout Monitor Group Status
(Percentage

Group List

Force

PTS

Dn Activity

Group Perfomance
Monitor

The above diagram shows the levels within the Group Monitor View
screens.

Using the left-hand mouse button, you move down a level:
Group → Real Time Status → Layout, Monitor, Group Status
(Percentage).

Using the right hand mouse button you obtain a summary of individual
directory number (i.e. Group, and Agents within the Real Time Status
screen).
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Group List
The Group Monitor allows high level monitoring of groups.  The Group List
is a conceptual top level group that comprises all the selected groups.

From the View menu, select Group Monitor, or from the toolbar, click .
The Group List screen appears.

The supervisor can view 6 groups on each screen and scroll to subsequent
screens to view more groups (up to a maximum of 10 screens) thus
enabling the supervisor to monitor large numbers of groups simultaneously.
At a glance, the supervisor can see the status of a group or if any alarms
have triggered on that group.
The group icon shows the current state of the group, if an alarm is
triggered the group icon will change to red to draw attention to the
exception.  It is possible to select five parameters for each group to be
displayed on the group icon.  In addition, five fields may be selected from
the list to be displayed, at the bottom of the screen, as totals for the
selected Agent groups.

Group Details
A group is represented by:

Individual Agent Group Details
To display summary information for a group, click (using the right hand
mouse button) the group, the Individual Agent Group Details screen
appears.  It is particularly useful as it provides a single screen summary of
group information in terms of call volumes, status of group members and
average call duration’s.
If an alarm has been set for any of the Calls Waiting; Longest Wait; PCA;
Lost alarm fields (see page 23 for the applicable Setup), when the alarm is
triggered, then the background color of the alarm field changes to red.  To
find out about alarms see "Alarm List" on page 52.

The background color of the Group Status changes to red, if the alarm has
been triggered.

The following information is available on Individual Agent Group Details
screen:

Group details:
Name The group name and directory number
Group Status The current status of the group
Group’s Members A list of the agent group’s members
Calls Waiting The total number of calls currently waiting for the group
PCA (Percentage Calls
Answered) *

The number of calls answered by the group within the
target answer time expressed as a percentage of calls
answered by the group

GOS (Grade Of Service) * The number of calls answered by the group within the
target answer time expressed as a percentage of calls
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answered and lost by the group
Longest wait The length of the current longest waiting call for this

group
Longest Waiting
(Answered) *

The longest waiting call before answer today

Longest Waiting (Lost) * The longest waiting call that was lost today by agent
Overflowed To The number of calls which originally rang another

directory number then rang this group and were
answered

Overflow From Calls that originally rang this group and then rang a
subsequent group

Agent Status:
Members The number of members in this group
Incoming The number of agents currently engaged on incoming

calls
Outgoing The number of agents currently engaged on outgoing

calls
Ready The number of agents currently ready to take incoming

calls
Ringing The number of agents whose extension is currently

ringing
Holding The number of agents currently holding calls
Busy Wrap up The number of agents currently in busy wrap up
Busy NA The number of agents currently in busy not available
Logged off The number of agents currently logged off
Call Totals (Today):
Incoming * The total number of incoming calls answered today
Outgoing * The total number of outgoing calls today
Lost * The total number of lost calls today
Refused * The total number of calls which rang the group and

were not answered by members of the group today
Transferred To * The total number of calls transferred to the group today
Transferred From * The total number of calls transferred from the group

today
Average Duration’s:
Incoming * The average duration of incoming calls today
Outgoing * The average duration of outgoing calls today

Note: Any metric with a ‘*’' indicates that a breakdown of internal or external call
statistics can be derived by pausing the cursor over these particular fields of
information.
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Real Time Status
Real Time Agent Status screen allowing the supervisor to view a number of
agents in real time.  An icon showing the agent’s name and current state
represents each agent; in addition, the supervisor may select one field to
be displayed within the agent icon.
From the Group Monitor screen, click (using left-hand mouse button) a
group, the Real Time Status screen appears.  This screen displays the
number of agents in the group, their individual status.

Real Time Status screen displays the name of the group as well as the
selected display information that is being monitored.
Using ‘drag and drop', the screen may be laid out to represent the office
layout from the supervisor’s perspective.
The statistics for the group are represented at the bottom of the screen.
These represent the total statistics information for the agents within the
group.
If an alarm has been set for any of the selected statistics (see page 23 for
the applicable categories), when the alarm is triggered, then the
background color of the selected statistics changes to Red.  To find out
about alarms see "Alarm List" on page 52.
To find out which Agents are set up in a higher numbered agent group than

the group on display, click  (Show members in higher Group) which
changes the agents background color to red.
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Monitor

To display a different statistics for the agents, click , the Monitor Display
Selection screen appears:

1. To change the Color, click the pull down arrow and select from the
listed options.  At present there is only State option implemented, future
versions of the application will support further options.

2. To change the Display, click the pull down arrow and select from the

listed options.  Click .
The available options are:
State Description
Time in State The time spent in the current state
Lost Calls All The total number of all incoming (internal and external)

unanswered calls by the agent today
Lost Calls Ext. The total number of external incoming unanswered calls

by the agent today
Answered All The total number of all calls (internal and external)

answered by the agent today
Answered Ext. The total number of external calls answered by the agent

today
Refused Calls All The total number of all calls (internal and external) which

rang the agent today which they did not answer
Refused Calls Ext. The total number of external calls which rang the agent

today which they did not answer
Calls Waiting The total number of calls waiting for the agent
PCA  All The number of all calls (internal and external) answered by

the agent within the target answer time as a expressed
percentage of calls answered by the agent

PCA Ext. The number of external calls answered by the agent within
the target answer time as a expressed percentage of calls
answered by the agent

GOS All (Grade of Service) The number of all calls (internal and
external) answered by the agent within the target answer
time as a expressed percentage of calls presented to the
agent

GOS (Grade Of
Service) Ext.

The number of external calls answered by the agent within
the target answer time as a expressed percentage of calls
presented to the agent

Outgoing All The total number of all outgoing calls (internal and
external) made by the agent today

Outgoing Ext. The total number of external outgoing calls made by the
agent today

Internal To The total number of internal calls received by the agent
today

Internal From The total number of internal calls made by the agent today
Longest Wait The longest waiting current call
L Wait (Ans) All The longest waiting of all calls (internal and external)

before answer today
L Wait (Ans) Ext. The longest waiting external call before answer today
L Wait (Lost) All The longest waiting of all calls (internal and external),

which was lost today, by the agent
L Wait (Lost) Ext. The longest waiting external call, which was lost today, by

the agent
Group Calls Answered The total number of incoming answered calls, answered

by agents for a particular agent group/campaign or total
calls answered for all agent groups for today/this shift

Group Calls Avg
Duration

The average duration of incoming answered calls,
answered by agents for a particular agent group/campaign
or the average duration of all calls answered for all agent
groups for today/this shift
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Agent Display Position
When you are viewing Real Time Status screen for the first time, the
agents within the group are cascaded.  Rearrange them by either selecting
the Auto Format Columns option, or using the drag-and-drop option.

By default, there are three preset positions.  Click the Layout button ,
to view the Layout Display Selection screen. Select one of the items on
the list, then click OK. If there are more than 12 agents in the group, then
Display Checkerboard option can not be selected.

Resize the Real Time Status screen by using  (moves the screen to

the left by one column) or  (moves the screen to the right by one
column).
If the Agent(s) position(s) have been altered manually (i.e. using the drag

and drop method) within the Real Time Status View screen, then click 
to return agent(s) position(s) to their last saved position. To save the new

position of the agents, click .

Group Status (Percentage)
This screen displays the percentage of the selected group's agents within
the five selected states (all other states being represented by the "Other(s)"
category.

From the View menu, select Percentage or from the Real Time Status

screen tool bar click , the Group Status (Percentage) screen appears.
This is a real time screen that shows a summary of the percentage of
agents in each state.
The statistics along the status bar of the screen represents the information
of the agents within the group.

Percentage Graph Format
The vertical axis of the graph represents percentage of agents in each
state and the horizontal axis represents time.  The graph shows historical
state percentages between Start Time and End Time.
There are two formats that the graph can be displayed.  Double click on the
graph to toggle between Bar and Area formats.

Agent Dn Activity
To view the status of the Agents within the Group in greater detail, from the

Real Time Status screen, click .  The Dn Activity screen appears.

You can change column widths by dragging the column boundaries in the

table itself, and then click .

Using the Dn Activity Set Up option , you can select the fields to be
displayed together with the order in which they appear on the screen.

Note:  The MINIMUM Update Period for this screen is 5 seconds.
Click (using the right mouse button) an agent, the Individual Agent
Details screen for the selected Agent will appear.
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Individual Agent Details
The Individual Agent Detail screen allows the supervisor to focus in on a
particular agent and view their activity per day or per shift.  The screen also
provides a list of the groups that the agent is a member of plus a
breakdown of the number of calls answered by the agent for each of these
group memberships, including the average duration of those calls.
Summary information for the agent’s activity for the day or their shift is also
available.

From the Real Time Status screen, more detailed information about an
agent may be obtained by, click (using the right mouse button) an agent,
the Individual Agent Details screen appears.  This screen contains real
time summary information for the day or shift.

Connected Device is displayed only when the directory number is
engaged in an incoming or outgoing call.  The number in the box indicates
the device the directory number is connected to.  When the directory
number is in a state other than Incoming and Outgoing, the Connected
Device is not displayed.

The fields available on the Individual Agent Detail screen are as follows:

State Description
Name The name and roaming agent number of the agent
Agent’s group list All the groups of which the agent is a member
Current status The current status of this agent
Time in state The amount of time that the agent has spent in their

current state
Time on duty (this
login)

The total time that this agent has spent on duty this login

Total time on duty
(today)

The total time that the agent has spent logged on today

Group Calls Answered
by agent

Breakdown of calls answered by the agent, by group, for
which they are a member of, including the average
duration of those calls.

Outgoing Call Rate The hourly outgoing call rate for calls, made by this agent.
Last Connected Caller
ID

Displays the Caller ID of last call, the agent was
connected (Internal and External).  It also contains a drop
down list of the last 9 Caller ID’s delivered, including
external Caller ID and internal id.

Last Number Dialed Displays the LND by the agent and which was connected
successful.  It also contains a drop down list of the last 9
numbers dialed (Internal and External) by the Agent.

Call Totals:
Incoming * The total number of incoming calls this agent has

answered today
Internal To The total number of internal calls received by the agent

today
Internal From The total number of internal calls made by the agent today
Outgoing * The total number of outgoing calls made by this agent

today
Lost * The total number of calls lost by the agent today
Refused * The total number of calls that have rung this agent that

have not been answered by this agent
Transferred To * The total number of calls that have been transferred to

this agent today
Transferred From * The total number of calls transferred by this agent today
Average Duration’s:
Incoming  * The average duration of incoming calls today
Outgoing  * The average duration of outgoing calls today
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Note:  Any metric with a ‘*’ indicates that a breakdown of internal or external call
statistics can be derived by pausing the cursor over these particular fields of
information.

Agent Picture
To obtain an agent picture, you will need to know the directory number for
the agent.
You must save the picture in C:\SDX\CallCenterView\MUGSHOTS
directory.  The file must be in BMP (Bitmap) form (256 colors and 130x120
Pels) with the file name as agent's directory number.bmp.
For example, if an agent's directory number is 2222, then you save the
picture as 2222.bmp within the C:\SDX\CallCenterView\MUGSHOTS
directory.
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Force Agent Status
Force option is only enabled if you are logged on with Access Level of

Administrator.  From the Individual Agent Details screen, click , the
Force Agent Status screen appears.

The Force Agent Feature allows the supervisor to act on the information
being received about the running of the Call Center.
For example: should an alarm appear showing an agent in Busy WrapUp
for longer than a defined threshold for that agent, the supervisor can, by
simply clicking on an agent, force them back into group.
This is a real time screen and shows the name and current status of the
selected agent in the group.  It allows you to change the agent's status.

Force Current Status

1 Click  associated with any of the status, then click .  The options
are:

  Force into Ready;
  Force into Busy WrapUp;
  Force into Busy NA

Force Agent Status
This feature is not currently supported.

PTS (Percentage Time Summary)

From the Individual Agent Details screen, click  the Percentage Time
in State screen appears.  The Percentage Time Summary screen provides
information via a real time pie chart showing, at a glance, the percentage of
time an agent has spent in each state today, or for the shift, and the
amount of time an agent has spent in each state.

Display Labels
The Percentage is represented in a pie chart format.  The colors on the pie
chart indicate which state has been selected.
The number associated with each color indicates the length of time (in
percentage) the agent has been in each state.
If you do not wish to see this information, click  associated with Display
Labels.

Select a different State
By default some of the states have been selected.

1. To select any of the states, click a  associated with that state.
2. To deselect any of the states, click a  associated with that state.
Save the selected States
Once you have selected the required states, click .  This will save the
selected states for of all the agents within that group.
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Trunk Group Monitor
This screen allows you to monitor the status of the Trunk Group List.
This is a real time screen and displays the status of the selected trunk
groups.  You can monitor only six trunk groups at a time.  This screen also
displays each group's selected statistics.
The features explained within the Trunk Monitor are:

• Trunk Groups on page 45
• Individual Trunk Group Details on page 45

• Real Time Status on page 45
• Monitor on page 46
• Trunk Display Position on page 47
• Group Status (Percentage) on page 47
• Individual Trunk Details on page 47

Trunk Group

Real Time Status

Individual Trunk Group Details

Individual Trunk Details

Layout Monitor Percentage

The above diagram shows the levels for monitoring trunks.  Using the left-
mouse button, you can move down a level.  Using the right mouse button,
you can obtain a summary of individual directory numbers (i.e. Group and
Real Time Status screens).
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Trunk Groups
From the View menu, select Trunk Group Monitor, or click .  The
Trunk Group Monitor View screen appears:

Trunk Group
A trunk group is represented by:

Individual Trunk Group Details
From Trunk Group Monitor screen, to find out detailed information about
a group, click (using the right hand mouse button) the group, the following
screen appears.  This screen provides information about the trunk group’s
activity for today or shift as well as the current status.

Real Time Status
From a Trunk Group, click (using the left-hand button of the mouse) the
group, the Real Time Status screen appears.  This screen shows the
number of trunks in the group, their individual status and the length of time
each trunk has been in that state.
The Dn Activity option is disabled when viewing this screen from a trunk
Group in this version of the CCV application.

Real Time Status screen displays the name of the group as well as the
selected display information that is being monitored.
The statistics for the group are represented at the bottom of the screen.
These represent the total statistics information of the trunks within the
group.
If an alarm has been set for any of the selected statistics (see page 23 for
the applicable alarm types), when the alarm is triggered, then the
background color of the selected statistics changes to Red.  To find out
about alarms see "Alarm List" on page 52.
To find out which Trunks are set up in a higher numbered trunk group than

the group on display, click  (Show members in higher Group) which
changes the trunks background color to red.



View Trunk Group Monitor

CCC Call Center View Page 46
User Manual 40DHB0002USBB Issue 2 (07/17/2001)

Monitor

To alter the Display Selection, click , the Monitor Display Selection
screen appears:

1. To change a state Color, click the pull down arrow and select from the

listed options.  Click .  At present there is only the State option
implemented, future versions of the application will support further
options.

2. To change the Display, click the pull down arrow and select from the

listed options.  Click .
3. To close the screen without making any changes, click .
The available options are:

State Description
Time in State The time spent in the current state
Lost Calls All The total number of all incoming (internal and external) unanswered calls

by the agent today
Lost Calls Ext. The total number of external incoming unanswered calls by the agent

today
Answered All The total number of all calls (internal and external) answered by the

agent today
Answered Ext. The total number of external calls answered by the agent today
Last Call Cost The cost of the last call made by the agent
Total Call Cost The total of outgoing call costs incurred by the agent today
Refused Calls All The total number of all calls (internal and external) which rang the agent

today which they did not answer
Refused Calls
Ext.

The total number of external calls which rang the agent today which they
did not answer

Calls Waiting The total number of calls waiting for the agent
PCA All The number of all calls (internal and external) answered by the agent

within the target answer time as a expressed percentage of calls
answered by the agent

PCA Ext. The number of external calls answered by the agent within the target
answer time as a expressed percentage of calls answered by the agent

GOS All (Grade Of Service) The number of all calls (internal and external)
answered by the agent within the target answer time as a expressed
percentage of calls presented to the agent

GOS Ext. (Grade Of Service) The number of external calls answered by the agent
within the target answer time as a expressed percentage of calls
presented to the agent

Outgoing All The total number of all outgoing calls (internal and external) made by the
agent today

Outgoing Ext. The total number of external outgoing calls made by the agent today
Internal To The total number of internal calls received by the agent today
Internal From The total number of internal calls made by the agent today
Longest Wait The longest waiting current call
L Wait (Ans) All The longest waiting of all calls (internal and external) before answer

today
L Wait (Ans) Ext. The longest waiting external call before answer today
L Wait (Lost) All The longest waiting of all calls (internal and external), which was lost

today, by the agent
L Wait (Lost) Ext. The longest waiting external call, which was lost today, by the agent
Group Calls
Answered

The total number of incoming answered calls, answered by agents for a
particular agent group/campaign or total calls answered for all agent
groups for today/this shift

Group Calls Avg
Duration

The average duration of incoming answered calls, answered by agents
for a particular agent group/campaign or the average duration of all calls
answered for all agent groups for today/this shift
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Trunk Display Position
When viewing Real Time Status screen for the first time, the agents within
the group are cascaded.  Rearrange them by either selecting the Auto
Format Columns option, or using the drag-and-drop option.

By default, there are three preset positions.  Click the Layout button ,
to view the Layout Display Selection screen. Select one of the items on
the list, then click OK. If there are more than 12 agents in the group, then
Display Checkerboard option can not be selected.

Resize the Real Time Status screen by using  (moves the screen to

the left by one column) or  (moves the screen to the right by one
column).
If the Agent(s) position(s) have been altered manually (i.e. using the drag

and drop method) within the Real Time Status View screen, then click 
to return agent(s) position(s) to their last saved position. To save the new

position of the agents, click .

Group Status (Percentage)
This screen displays the percentage of the selected group's trunks within
the five selected states (all other states being represented by the "Other(s)"
category.

From the View menu, select Group Status (Percentage) or from the tool

bar click , the following screen appears.  This is a real time screen that
shows a summary of the percentage of trunks in each state.
The statistics along the status bar of the screen represents the information
of the trunks within the group.

Percentage Graph Format
The vertical axis of the graph represents percentage of agents in each
state and the horizontal axis represents time.  The graph shows historical
state percentages between Start Time and End Time.
There are two formats that the graph can be displayed.  Double click on the
graph to toggle between Bar and Area formats.

Individual Trunk Details
From the Real Time Status screen, detailed information about a trunk, may
be obtained by click (using the right hand mouse button) the trunk, the
Individual Trunk Details screen appears.  This screen provides
information about the trunk status within the group as well as call statistics
and costs.
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Queue Monitor
This screen allows you to monitor the selected directory number's response
statistics in real time.  This screen is used to monitor trunks, trunk groups,
agents and agent groups.

From the View menu, select Queue Monitor, or click .

Queue Monitor screen displays the name of the selected directory
number(s) as well as the selected display information that is being
monitored.
The statistics for all the selected directory number(s) are represented at the
bottom of the screen.  These represent the total statistics information of the
selected directory number(s) within the Queue Monitor screen(s).
If an alarm has been defined for any of the selected statistics (see page 23
for the applicable alarm types), when the alarm is triggered, then the
background color of the selected statistics changes to Red.  To find out
about alarms see "Alarm List" on page 52.
The number of Calls Waiting and the ring time of the Longest Waiting call

are also represented with an Alarm Warning Meter .
If you have specified alarms for Calls Waiting and Longest Waiting Call
categories (see page 23), as the real time value increases the Alarm
Warning Meter reflects the change by illuminating green, amber and red
segments.
If you have defined alarm for Calls Waiting, Longest Waiting, Lost and PCA
(see page 23), the background color of the numerical indicators change(s)
to red.

Next/Previous Queue Monitor List
The next and previous buttons are always enabled, since it is possible to

rotate the Queue Lists (total of 20 list screens).  In the first screen, the 
button allows you to view the last Queue list screen.  In the last screen, the

 button allows you to view the first Queue list screen.

Click   to view previous/next screen.

Individual Group Details
To find out detailed information about group directory number(s), click
(using the right mouse button), the summary screen for the selected group
directory number appears.  This screen provides information about the
status of the selected directory number.
Further details are available in “Group Details” on page 36.

Individual Agent Details
To find out detailed information about agent directory number(s), click
(using the right mouse button), the summary screen for the selected agent
directory number appears.  This screen provides information about the
status of the selected directory number.
Further details are available in “Individual Agent Details” on page 41.
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Individual Trunk Group Details
To find out detailed information about trunk group directory number(s), click
(using the right mouse button), the summary screen for the selected trunk
group directory number appears.  This screen provides information about
the status of the selected directory number.
Further details are available in “Trunk Groups” on page 45.

Individual DID Details
To find out detailed information about DID directory number(s), click (using
the right mouse button), the summary screen for the selected DID directory
number appears.  This screen provides information about the status of the
directory number.

Find Directory Number
1. If you have configured two or more Queue List screens, to search for a

directory number in one of the screens, click .  The Find Dn screen
appears.

2. If you know the directory number’s name, then place the mouse cursor
in the Dn Name text box and type the first letter of the name.  You will
notice all the selected directory numbers, within the Queue Monitor
screens, beginning with that letter are automatically listed in the Results
box.

3. The above procedure is also applicable for the Dn Number.  Place the
mouse cursor in the Dn Number box and type the first digit.  You will
notice all the directory numbers beginning with that number are
automatically listed in the Results box

4. To select the required directory number, double click it from the Results
box.  However if there is only one directory number listed within the
Results box, Go to is enabled.  Select the directory number, and then
click Go to.  Queue Monitor incorporating the selected directory number
will now be displayed.

5. To close the screen, click Exit.
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BLF Details
This screen allows you to monitor the status of the selected directory
number(s) (e.g. groups, agents or trunks etc.).  This is a real time screen
and displays the status of the selected directory numbers as well as their
status.

1. From the View menu, select BLF Details, or click .  The BLF
Details screen appears.

You can resize the BLF Details screen by using  (moves the screen to

the left by one column)  (moves the screen to the right by one column).

Using , you can move the position of the selected directory number
up or down the screen.

Individual Summary screens
To find out detailed information about any of the above selected directory
number(s) (i.e. group/agent/trunk/DID) click (using the right mouse button)
the directory number, the summary screen for that directory number
appears.  This screen provides information about the status of the directory
number.
The individual summary screens are:

• "Individual Group Details" on page 48
• "Individual Agent Details" on page 48
• "Individual Trunk Group Details" on page 49

Monitor
To display a different state, click , the Monitor Display Selection
screen appears.

1. To change the State Color, click the pull down arrow and select from

the listed options.  Click .  At present there is only State option
implemented, future versions of this application will support further
options.

2. To change the Display, click the pull down arrow and select from the

listed options.  Click .
3. To close the screen without making any changes, click .

BLF Dn Activity (BLF)
To view the status of the selected directory numbers within the BLF Details

screen, in greater detail, click .  The Dn Activity screen appears.

You can change column widths by dragging the column boundaries in the

table itself, and then click .

Using the Dn Activity Set Up option , you can select the fields to be
displayed together with the order in which they appear on the screen.

Note - The minimum Update Period settings for this screen is 5 seconds.
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Dn Activity
To view the status of directory numbers in greater detail, click , which is
also available from the following View screens:

Agent Real Time Status, see "Agent Dn Activity" on page 40
BLF Details, see "BLF Dn Activity" on page 50

Individual Summary screens
To find out detailed information about any of the selected directory
number(s) (i.e. group/agent/trunk/DID) click (using the right mouse button)
the directory number, the summary screen for that directory number
appears.  This screen provides information about the status of the directory
number.
The individual summary screens are:

• "Individual Group Details" on page 48
• "Individual Agent Details" on page 48
• "Individual Trunk Group Details" on page 49
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Alarm List
This screen allows you to monitor the alarms as they occur.  This is a real
time screen that displays the alarm status of the directory numbers.  The
screen displays both the Unacknowledged Alarms (in red) and
Acknowledged Active Alarms (in Blue).
When an alarm occurs, the directory number's status background color
changes to red.  The  (green) Alarm indicator on the top right of the CCV
main screen, flashes  /  (red/yellow) enabling the First Alarm button

.  The First Alarm button stays enabled until all the alarms have been
acknowledged.

Alarm indicator status:

 (green) – No active alarm

 /  (red/yellow) – Unacknowledged alarm

 (red) – Acknowledged active alarm
There are two ways of finding out the alarm information.

Method 1
Click the  /  (red/yellow) flashing indicator. Click a directory number
(using the right mouse button), Individual Dn Details screen for the
selected directory number appears

Method 2

From the toolbar click , the Alarm List screen together with the
Individual Directory Number Details screen appear:
The Individual Directory Number Details screen is the first entry in the
Alarm List.



View Alarm List

CCC Call Center View Page 53
User Manual 40DHB0002USBB Issue 2 (07/17/2001)

Unacknowledged Alarms
Unacknowledged Alarms list box displays (in red) the alarms as well as the
accumulative number of the alarms currently active.  The Alarm indicator
will be flashing  /  (red/yellow).  The Alarms are listed chronologically
(Top is the oldest).
Once an alarm has been cleared within the telephone system, it remains in
this list until it is acknowledged.
Each alarm is displayed in the following format: Name, Dn, and Alarm
Details

1. To Acknowledge an individual directory number alarm, double click the
required directory number.

2. To Acknowledge all the alarms within the list, click .

Acknowledged Active Alarms
If an alarm is still active, once it is acknowledged, it will be displayed (in
blue) in the Acknowledged Active Alarms list box.  The Alarm indicator

 (red) will be displayed.
When a directory number alarm is cleared, it will automatically be removed
from the list box.
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Individual Summary screens
To find out detailed information about any of the directory number(s) in the
Alarm List screen, (i.e. group/agent/trunk/DID) click (using the right mouse
button) the directory number, the summary screen for that directory
number appears.  This screen provides information about the status of the
directory number.
The individual summary screens are:

• "Individual Group Details" on page 48
• "Individual Agent Details" on page 48
• "Individual Trunk Group Details" on page 49

Group Performance
Agent group and campaign performances monitoring are an essential
element of the supervisor’s daily activity.  The group performance monitor
enables the supervisor to instantaneously analyze, by a summary
breakdown, the performance of the top 50 agent groups.
This enables Call Centers, who have incentive schemes running, to target
their top performers.  Supervisors could also project this screen onto a
wall-mounted monitor to encourage competition between agent groups.
Alternatively, it enables supervisors to have a real time understanding of
what campaigns are the most or least successful.

From the View menu, select Group Performance, the Group Performance
Monitor screen appears.
The number of incoming calls answered by each individual agent group
categorizes the top 50 performing agent groups or campaigns.

Note - XXXX within the screen represents the Group Number.
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Profile
General

This section details the Profile options within the CCV.  The options are:

• Log on a different Profile
• Create a new Profile
• Remove a Profile

Logon Profile
This option allows you to change the CCV Profile without having to exit the
application.

1. From the Profile menu, select Logon Profile, the Logon Profile screen
appears.

2. Click the pull down arrow to display a drop down list of the existing
Profiles.

3. Click the required name, then click Logon.
4. The CCV loads the new Profile's configuration and the call statistics for

that day.

Create New Profile
This option allows you to create a new Profile.  However, you need to have
logged onto CCC User Access with the user name of Admin.

1. From the Profile menu, select Create Profile, the Create Profile
screen appears.

2. Type in a user name, click Create.
3. From the confirmation screen, click Yes to create the Profile.
4. From the confirmation screen, click No to return to Create Profile

screen, to modify the name.

Remove Profile
This option allows you to remove a Profile.  However, you need to have
logged onto CCC User Access with the user name of Admin.

1. From the Profile menu, select Remove Profile and the Remove Profile
screen appears.

2. Click the pull down arrow to display a drop down list of the existing
Profiles.

3. Click the required name, then click Remove.
4. From the confirmation screen, click Yes to remove the Profile.
5. From the confirmation screen, click No to cancel the confirmation

screen.
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System Admin
Reset Stats

This option allows you to reset the statistics for a selected directory
number.

From the System Admin menu, select Reset Stats, the Reset Stats
screen appears.

Select Directory Number
You can either reset the call statistics for all the directory numbers or an
individual one.

• Reset All DNs: This allows you to reset the call statistics for all the
directory numbers within the telephone switch.  This is the default
setting.

• Reset Single DNs: This allows you to reset the call statistics for an
individual directory number within the telephone switch.
To select an individual directory numbers, double click Dn Name text
box and follow the instructions detailed on page 24.  Alternatively, use

the spin button  until the required time appears in the left-hand box.

Select Stats
There are three Reset Statistics options:

• Today Stats – Resets all the statistics of the day (e.g. Lost calls),
excluding ISDN information;

• ISDN Shift Info – Resets all the ISDN related information of the day
(e.g. Last Call Cost);

• ISDN Total Info – Resets the total ISDN information since the last
reset (e.g. Total Lost Records).

1. To select any of the options, click  associated with that option.
2. To deselect any of the options, click a  associated with that option.
3. Once you have selected your option(s), click Reset.
4. Click Yes to confirm your request.
5. Click No to close the confirmation screen.
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PCA Target Time
This option allows you to set PCA (Percentage of Calls Answered) Target
Time for any directory number within the Telephone switch. From the
System Admin menu, select Set PCA Target Time, the Set PCA Target
Time screen appears:

Select Directory Number
To select an individual directory numbers, double click Dn Name text box
and follow the instructions detailed on page 24. Alternatively, use the spin

button  until the required time appears in the left-hand box.

Set PCA Target Time
PCA Target Time sets the time, in seconds, and is used to calculate the
directory number's PCA (service level).  By default, PCA Target Time is
set to 45 seconds.  The range is 1–360 seconds.
1. To change the PCA Target Time, click and hold the mouse on the spin

button  until the required time appears in the left-hand box.
2. Once you have selected your time for the selected directory number,

click Set.
3. Click Yes to confirm your request.
4. Click No to close the confirmation screen.
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Answer Time
Each DID must be directed to a unique group to use thus functionality. The
Answer Time (Secs) reflects a successive cumulative sequence of answer
time bandwidth.  It indicates the number of DID calls were answered within
the time bandwidth.

From the System Admin menu, select Answer Time, the Set Answer
Time screen appears.

Select Directory Number
To select the directory numbers, double click Dn Name text box and follow
the instructions detailed on page 24.

Alternatively, use the spin button  until the required time appears in the
left-hand box.

Set Answer Time
The left-hand column allows you to change the bandwidths A to F
individually.  The right hand column displays the cumulative answer time
boundaries as monitored on Dn Activity as well as Individual DID Details
View screens.
1. To change the Ans Time (A–F), click and hold the mouse on the spin

button  until the required time appears in the left-hand box.  The time
changes in 1 second intervals.  The range is 1-120 seconds

Note - When you alter one of the Answer Times (e.g. Ans Time C) the others down
from the selected one (i.e. Ans Times D, E and F) also change by the same value.
2. Once you have selected your time for the selected directory number,

click Set.
3. Click Yes to confirm your request.
4. Click No to close the confirmation screen.

Reset Time
This option allows you to define the reset time for "Today Stats" and
"ISDN Shift Info" fields.  These fields are reset daily.

1. From the System Admin menu, select Reset Time, the Set Reset
Time screen appears:

2. To change the time, highlight the fields individually, "Hour:Minute", then

click the spin button  to obtain the required time.  Click Set
3. Click Yes to confirm your request.
4. Click No to close the confirmation screen.
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Performance figures and data quoted in this document are typical, and
must be specifically confirmed in writing by Avaya before they become

applicable to any particular order or contract. The company reserves the
right to make alterations or amendments to the detailed specifications at its

discretion. The publication of information in this document does not imply
freedom from patent or other protective rights of Avaya, or others.

Intellectual property related to this product (including trademarks) and
registered to Lucent Technologies has been transferred or licensed to
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